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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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APPLICATION NOTE 

1. Layered Projects 

1.1 Overview of layered projects 
In large-scale application development, applications are often developed using a library for each piece of functionality. 
This means that a project needs to be created for the application, and also for each library, resulting in multiple projects in 
the workspace. 

Also, when an application and its libraries are developed at the same time, the library projects need to be built before the 
application project, because the library functions called by the application may have been updated. Renesas IDE allows 
project dependencies to be specified, to enable project layering and systematic builds. 

When projects are given dependencies, and a project from which a dependency is specified (a parent project) is built, the 
project to which the dependency is specified (child project) is first checked for updates, and is built first if updated. Then, 
the parent project is built. 

 

Parent project 
 

: Unchanged project  
 : Changed project 
 
 
 
 
 
 
 

Dependency Dependency Dependency

 

Child project 1 Child project 2  
 
 

Child project 3 

 
 
 
 
 
 
 
 

Child project 1 Child project 2 Child project 3 Parent project 

Note that the order in which sibling projects are built cannot be specified. 

Skip Skip Build Build 

Build order 

Figure 1-1 

 
Note that the build order cannot be specified for sibling projects, and that a child project specified for another child 
project (a grandchild project) is not built when the parent project is built. 

Also, when a child project is built before its parent project, the configuration used for the child project build is the same as 
that of the parent project. However, when a configuration only existing for a parent project is set, the configuration for the 
child project is the last configuration used for a child project. 
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1.2 Setting up layered projects 
The following explains how to set up a layered project, starting with how to insert multiple projects into a workspace. 

To insert a project into an existing workspace, from the Project menu, choose Insert Project to display the Insert 
Project dialog box. This dialog box allows a new project or an existing project to be inserted. 

 

 
 

Figure 1-2 

To create a library project, select New project, and then select Library for the project type. 

 

 
 

Figure 1-3 

 

REJ06J0032-0100/Rev.1.00 January 2008 Page 3 of 16 



 
APPLICATION NOTE 

The following explains how to give dependencies to a project. 

To give a project dependencies, from the Project menu, choose Dependent Projects to display the Dependent Projects 
dialog box. From the Project dropdown list, choose the project to use as the parent project. In the Dependent projects 
list, select the checkboxes for the projects to be used as child projects. 

 
 

Figure 1-4 

 
Note that if only the dependent project is specified, the library will not be entered into the linker, causing the following 
error to occur when the parent project is built: 

L2310 (E) Undefined external symbol "symbol" referenced in "file"
 
When using a library in an application project, specify the library in the linker, in addition to the dependent project setting. 
Perform these settings as follows in the Renesas IDE. 

From the Build menu, choose SuperH RISC engine Standard Toolchain to display the SuperH RISC engine 
Standard Toolchain dialog box. Then, select the Link/Library tab, and select Input for Category, and Library files 
for Show entries for, and click the Add button. In the displayed Add library file dialog box, specify the libraries to be 
linked. 

 
 

Figure 1-5 
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2. Project Types 

2.1 Overview of project types 
Project types can be created as project templates, and used to set the settings for the current project (including its file 
structure, options, configuration, custom build phase, and session). Created project types can be selected when a new 
project is created, in which case the settings of the source project are carried over to the new project. This allows 
replicated projects to be created. Project types can also be imported and exported to facilitate creation of replicated 
projects on other computers. This is useful when projects need to be derived due to application upgrades and revision 
upgrades. 

 Note: 
When a project type is used to create a project, files outside the project directory are not replicated. The following 
warning is displayed before the New project type wizard dialog box is displayed: 

 

 
 

Figure 2-1 

 
The following table lists the path information for files created using a project type. 

Table 2-1 Information about Files Created Using a Project Type 

Project from which the Project Type Was Created Project Created Using the Project Type 
File Location Path Information File Replication Path Information 

Within the project directory Absolute path Replicated Substituted with the absolute path of the replicated 
file. 

Within the project directory Relative path Replicated Substituted with the relative path from the 
replicated file project. 

Outside the project directory Absolute path Not replicated Unchanged from the original file path information.
Outside the project directory Relative path Not replicated Substituted with the relative path from the project 

directory, as the files in the project directory. 
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2.2 Creating and deleting project types 
To create a project type from a project, first activate the project from which the project type is to be created, and then save 
the workspace. Then from the Project menu, select Create Project Type to display the New project type wizard - 
Step1 dialog box. In the New project type wizard - Step1 dialog box, enter the name of the project type to be created, 
and click the Finish button. 

Click the Next button to set the graphics and project type icon for the project generation wizard. 

 
Figure 2-2 

When a project type is created, it is displayed in the Tools Administration dialog box. When Administration is selected 
in the Tools menu, the Tools Administration dialog box is displayed. When the Show all components checkbox is 
selected in the Tools Administration dialog box, the created project type is displayed as Project Generators - Custom 
for the registered components. 

To delete a created project type, close all workspaces, and then open the Tools Administration dialog box. In the Tools 
Administration dialog box, select the project type to be deleted, and then click the Unregister button. 

 
Figure 2-3 

REJ06J0032-0100/Rev.1.00 January 2008 Page 6 of 16 



 
APPLICATION NOTE 

Created project types are listed in the Project Types list, in the dialog box for creating projects. 

 

 
 

Figure 2-4 

 
A project can be created from an added project type, to replicate the project from which the project type was created. In 
the New Project Workspace dialog box (Figure 2-4), select a created project type. The project created will have the same 
settings (except for the project name) as those for the project from which the project type was created. For example, the 
file configuration for a project created using a project type is as follows. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Replication source project Replication target project 

 
Figure 2-5 
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2.3 Exporting and importing project types 
Project type export/import functionality allows project types to be used on computers other than that on which a project 
type was created. Once a project type is created on one computer, it can be exported to another. When export is performed, 
a Setup.exe file executable is created to add a project type. This file can then be executed on another computer to 
import the project type and allow the project type to be used on the computer. 

 

2.3.1 Exporting project types 
The following explains how to export a project type. 

From the Tools menu, choose Administration to display the Tools Administration dialog box. In the Tools 
Administration dialog box, select the Show all components checkbox, to display the created project types in Project 
Generators - Custom for registered components. Select the project type to be exported, and click the Export button to 
display the Export Custom Project Generator dialog box. In the Export Custom Project Generator dialog box, 
specify a directory that is empty or does not exist for the directory export destination. 

 

 
 

Figure 2-6 

 
When the Export button is clicked, a set of installation files is created in the specified directory, including the 
Setup.exe file. For example, when a project type named PJ_Type is exported, the following files are generated in the 
specified directory. 

 

 
 

Figure 2-7 

 

2.3.2 Importing project types 
The following explains how to import a project type. 

Copy the set of installation files created in 2.3.1 Exporting project types, including the Setup.exe file, to the computer 
to which import is to be performed. With Renesas IDE stopped, execute Setup.exe to display the Install custom 
generator dialog box. In the Install custom generator dialog box, specify the HEW2.exe file in the installation 
directory of the Renesas IDE to which imported is to be performed. Then, click the Install button to add the project type. 

 

 
 

Figure 2-8 
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The added project type can be checked in the Tools Administration dialog box. From the Tools menu, choose 
Administration to display the Tools Administration dialog box. In the Tools Administration dialog box, select the 
Show all components checkbox to display the added project type in Project Generators - Custom for registered 
components. 

Note that the toolchain used by the project from which the project type was created may not exist on the import 
destination computer in the following cases: 

• The only toolchain available is one less recent than the creation source toolchain 
A warning window indicating that no compatible toolchain exists is displayed. The generated project will not 
be able to be built. 

 

 
 

Figure 2-9 

 
• The only toolchain available is one more recent than the creation source toolchain 

When a project is created from a project type, its toolchain can be upgraded. 
To upgrade a toolchain, from the Toolchain missing dialog box, select the checkbox for the project, and click 
the OK button. To skip toolchain upgrade, click the Cancel button. Note that in the latter case, the generated 
project will not be able to be built. 

 

 
 

Figure 2-10 
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When a toolchain is upgraded, the Change Toolchain Version dialog box is displayed. Choose the 
appropriate toolchain and click the OK button. 

 

 
 

Figure 2-11 
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3. Exporting and Importing Makefiles 

3.1 Makefile overview 
The make command and makefiles are helpful for projects built using the command line. 

Renesas IDE allows a makefile to be generated from a project, and can handle the GNU Make, NMake, and HMake 
makefile formats. HMake is installed in the installation directory when the Renesas IDE is installed. For details about 
HMake, see High-performance Embedded Workshop V.4.02 User's Manual Reference - 13. HMAKE User Guide. Those 
using GNU Make or NMake must provide each themselves. 

3.2 Creating makefiles 
To generate a makefile, from the Build menu, choose Generate Makefile to display the Generate Makefile dialog box. 
Click the OK button to generate the makefile with the specified makefile name, in the make directory of the workspace. 

 

 
 

Figure 3-1 

The items set are as follows: 

• Select a makefile type in Generate makefile for. 
⎯ the current configuration in the currently active project 
⎯ all configurations in the currently active project 
⎯ all configurations in all loaded projects in the current workspace 

• Enter the file name in the MakeFile name edit box. To insert a placeholder, place the cursor at the position where you 
wish to insert the placeholder, click the placeholder button, and select Placeholder from the pop-up menu. The default 
makefile names are as follows. 
⎯ When "the current configuration in the currently active project" is selected: 

$(PROJECTNAME)_$(CONFIGNAME).mak 
⎯ When "all configurations in the currently active project" is selected: $(PROJECTNAME).mak 
⎯ When "all configurations in all loaded projects in the current workspace" is selected:$(WORKSPNAME).mak 

• Select a makefile format in the Makefile format drop-down list. HEW is capable of generating GNUMake, HMake 
and NMake compatible files. 

• In the Relative paths drop-down list, select how directories within the makefile should expressed. “Workspace 
directory and below only” is the default option. See the table below for details. 
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Table 3-1 Path Information for the Relative Path Selection 

Option Workspace Directory and below Outside the Workspace Directory
None Absolute path Absolute path 
Workspace directory and below only Relative path Absolute path 
All Relative path Relative path 
• Selecting the Scan dependencies whilst building make file checkbox will execute a dependency scan before 

creation of a makefile. This checkbox is selected by default. 
 

3.3 Executing "make" 
3.3.1 Executing "make" on the command line 
The following explains how to use a created makefile to execute the hmake command on the command line. To use 
hmake, when creating a makefile in Renesas IDE, select HMake for Makefile format. 

hmake is used as follows. For details, see High-performance Embedded Workshop V.4.02 User's Manual Reference - 13. 
HMAKE User Guide. 

• Command line syntax 
The command line syntax is as follows: 

hmake makefile parameter-list 

If the file is specified without an extension, .mak is appended. 
• Parameters 

The following table lists the parameters that can be specified. 
 

Table 3-2 Parameters that Can Be Specified for the hmake Command 

Parameter Functionality 
/A Execute all commands regardless of input/output file status. Equivalent to a Build All. 
/N Use status of input/output files to calculate what commands need to be executed (as normal) 

and then display the commands but do not execute them. 
/? Displays help info. 
val=val Defines a macro. 

Makefiles created by Renesas IDE can be specified as follows for build configuration and 
project specifications: 
• When a makefile for building multiple configurations is used, CONFIG=configuration-name 

can be specified to perform build for the specified configuration. 
• When a makefile for building multiple configurations is used, PROJECT=project-name can 

be specified to perform build for the specified project. 
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3.3.2 Executing "make" in Renesas IDE 
The following explains how to perform builds using make in Renesas IDE. 

To perform settings for builds using make, from the Setup menu, choose Options, and click the Build tab in the 
displayed Options dialog box. Select the use makefile build system (for this workspace) checkbox to perform builds 
using the makefile instead of using Renesas IDE. 

 
 

Figure 3-2 

 
The following explains the settings other than for builds using a makefile: 

• Enter the make tool name to execute the makefile in the Command (excluding parameters) edit box. The default is 
hmake ($(HEWDIR)\hmake.exe). 

• While the Generate makefile before build commences checkbox is selected, the Renesas IDE will generate a 
makefile before executing the build. This means the makefile will always be up to date with the Renesas IDE project 
system. 

• Enter the file name in the MakeFile filename edit box. The default file name is 
$(PROJECTNAME)_$(CONFIGNAME).mak. 

• In the Initial directory edit box, enter the current directory where the makefile is to be executed. When this edit box is 
empty, the directory where the makefile specified in the MakeFile filename edit box is stored is assumed as the 
current directory. 

• Enter the options for building the makefile in the Makefile options edit box. 
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3.4 Importing makefiles when creating a project 
When a project is created, file information and option information can be analyzed from the makefile and imported into 
the project. Note that importing is not guaranteed for makefiles not generated by Renesas IDE, and that custom build 
phase information is not imported. 

To import a makefile, select a project type in the dialog box for creating a project, select Import Makefile, and then click 
the OK button. 

 
Figure 3-3 

The New Project dialog box is displayed. For Makefile path, specify the makefile to be loaded. When the makefile is 
specified, the files registered in the makefile are displayed in the Source files list. 

To import the compiler and other tool options, select the Import options checkbox. 

Any unnecessary files can be deleted when selected and the Remove button is clicked, and files can be added by clicking 
the Add button. To redisplay the files registered in the makefile in the source file list, click the Start button. When the 
Show file path checkbox is selected, the names of the files in the source file list are displayed as absolute paths. 

 
Figure 3-4 
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APPLICATION NOTE 

1. This document is provided for reference purposes only so that Renesas customers may select the appropriate 
Renesas products for their use. Renesas neither makes warranties or representations with respect to the 
accuracy or completeness of the information contained in this document nor grants any license to any  intellectual 
property rights or any other rights of Renesas or any third party with respect to the information in  this document. 

2. Renesas shall have no liability  for damages or infringement of any intellectual property or other rights arising  out 
of the use of any information in this document, including, but not limited to, product data, diagrams, charts,  
programs, algorithms, and application circuit examples.

3. You should not use the products or the technology described in this document for the purpose of military 
applications such as the development of weapons of mass destruction or for the purpose of any other military  
use. When exporting the products or technology described herein, you should follow the applicable export  
control laws and regulations, and procedures required by such laws and regulations.

4. All information included in this document such as product data, diagrams, charts, programs, algorithms, and  
application circuit examples, is current as of the date this document is issued. Such information, however,  is  
subject to change without any prior notice. Before purchasing or using any Renesas products listed in this  
document, please confirm the latest product information  with a Renesas sales office. Also, please pay regular  
and careful attention to additional and different information to be disclosed by Renesas such as that disclosed  
through our website. (http://www.renesas.com)

5. Renesas has used reasonable care in compiling the information included in this document, but Renesas  
assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information  
included in this document.

6. When using or otherwise relying on the information in this document, you should evaluate the information in  light 
of the total system before deciding about the applicability of such information to the intended application. 
Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any  
particular application and specifically disclaims any liability arising out of the application and use of the  
information in this document or Renesas products.

7. With the exception of products specified by Renesas as suitable for automobile applications, Renesas  products 
are not designed, manufactured or tested for applications or otherwise in systems the failure or  malfunction of 
which may cause a direct threat to human life or create a risk of human injury or which require  especially high 
quality and reliability such as safety systems, or equipment or systems for transportation and  traffic, healthcare, 
combustion control, aerospace and aeronautics, nuclear power, or undersea communication  transmission. If you 
are considering the use of our products for such purposes, please contact a Renesas  sales office beforehand. 
Renesas shall have no liability for damages arising out of the uses set forth above.

8. Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:
  (1) artificial life support devices or systems
  (2) surgical implantations
  (3) healthcare intervention (e.g., excision, administration of medication, etc.)
  (4) any other purposes that pose a direct threat to human life
 Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who 

elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas  
Technology Corp., its affiliated companies and their officers, directors, and employees against any and all  
damages arising out of such applications.

9. You should use the products described herein within the range specified by Renesas, especially with respect  to 
the maximum rating, operating supply voltage range, movement power voltage range, heat radiation  
characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or  
damages arising out of the use of Renesas products beyond such specified ranges.

10. Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific  
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use  conditions. 
Please be sure to implement safety measures to guard against the possibility of physical injury, and  injury or 
damage caused by fire in the event of the failure of a Renesas product, such as safety design for  hardware and 
software including but not limited to redundancy, fire control and malfunction prevention,  appropriate treatment 
for aging degradation or any other applicable measures.  Among others, since the  evaluation of microcomputer 
software alone is very difficult, please evaluate the safety of the final products or system manufactured by you.

11. In case Renesas products listed in this document are detached from the products to which the Renesas  products 
are attached or affixed, the risk of accident such as swallowing by infants and small children is very  high. You 
should implement safety measures so that Renesas products may not be easily detached from your  products. 
Renesas shall have no liability for damages arising out of such detachment.

12. This document may not be reproduced or duplicated, in any form, in  whole or in part, without prior written  
approval from Renesas.

13. Please contact a Renesas sales office if you have any questions regarding the information contained in this 
document, Renesas semiconductor products, or if you have any other inquiries.
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